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Preface 

 

Users installing and operating the product is required to understand this manual and relative 

manuals fully before installation and operation. 

 

All rights of the software and hardware described in the manual are protected by the patent 

law. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note 

This icon means “Note” explaining the procedure and additional 

information. 

 

 

Caution 

This icon means “Caution” explaining important information or 

limitations of the operation. . 
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1.  Overview 

1.1  Introduction 

This program is Central Management System that is designed to control various security 
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devices (IP camera, DVR, NVR, Video Sever) connected from a single PC by networking. 

This program consists of the multi-functions including the live image monitoring, real-

time event management, security device status monitoring, and then image search, 

playback, download, smart search and watermark etc. 

 

1.2  Feature 

In the program, users can register security devices and it provides a real-time multi 

monitoring. Users can control a function window size as each function has a separate 

window.  

 

This program manages the user account and group. It provides a separate management of 

the user account by allowing the administrator to set the authority of detail features for 

the group. 

This program manages and saves events that were sent from many security devices. This 

program reports users an alarm set with events through the pop-up message, audio and 

real-time image etc. 

 

In the network player, users can search the recorded file and play and download the 

image and audio. A searching term by second is available and the preview screen enables 

users to search images without playing actual images. 

 

The recorded file with images and audios in PC can be played by File Player and it 

provides a faster search of information by the smart search and water mark. 

 

     

 

 

2.  Installation 

2.1  System Requirement  

In order for proper operation of the program, it requires PC more than the min. 

specification. With the min. specification, it only provides min. functions. For full 

operation of the program, PC is required to be equipped with more than the recommended 

specification. 
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System Min. Specification Recommend Specification 

CPU Intel Core2Duo 2.0GHz Intel Core2Quad 2.66GHz 

Main Memory 2GB 4GB or higher 

Video Card Memory 128MB 512MB or higher 

Display Resolution 1024 * 768 (With 32bit color) or higher 

HDD 80GB or higher 

OS Windows XP SP2 or higher 

Others Direct X 9.0 or higher 

 

2.2  Installation Guide 

1. Insert software CD into the CD drive of PC. 

 

2. Click on Setup.exe. An install program will be executed and a language selection page 

will shows up. 

 

 

3. Select a desired language. 

 

4. Designate a folder in which the program is installed and click on “Next”, and then 

installation starts. 

 

3.  System Login 
System Login is to decide a program execution/block by confirming the user name and 

password. 

 

3.1  Site Registration 

1. In the program start menu, go to VMS and select VMS icon or double-click on Vin 
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the wallpaper, and then the login window pops up. 

 

2. Select one of the names of registered users in the login window. For the first time 

login, select Administrator. Administrator is registered as a fundamental user. 

 

 

3. Enter a password. For the first time login, enter an administrator password. The 

administrator password “1111111”. After login, change the administrator password. 

 

 

4. The program starts if the password is right.  

 

 

4.  Initial Instruction 

4.1  Site Registration 

Security devices need to be registered after login. With registered security devices, 

users can use functions including real-time monitoring, search and playback, backup and 

event alarm. 

 

 

 

Note 

 

■ To change the password, go to ‘Setup’->‘Password Change’ menu. 

(For more information, refer to ‘5.2.9 Password Change’. 

■ In VMS, multi-user registration is available, all users can log in one 

PC with separate user information. Each user can configure a 

preferred program environment, and then the program starts 

according to each user’s setting after login. 

■ Information of the latest window environment will be saved when the 

program is closed. 
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4.1.1 Registration 

1. Select ‘Setup’->’Site Manager’ menu. Site Manager Setup window shows up. 

 

2. In Site Manager, functions including, all select, all clear and modify are available. 

Selected sites will be listed on the Connect list from the main system window.  

 

 

3. Select ‘Edit’ menu. “Edit site list” window shows up. 

 Users can modify the sites and search&add the security device in the local network 

 

 

4. In “Add”, users can register the security device.  
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5. In ‘Modify’ users can modify the security device name, connect address and port. 

 

6. In ‘Delete’, users can delete selected sites. 

 

 

Item Description 

Name Name of the security device to be used in the program 

Description Description of the security device 

Connect Address Network address of the security device 

Port Network port no. of the security device 

Camera Count The number of cameras connected to the security device 

User Name User name registered in the security device 

Password Password registered in the security device 
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7. In ‘Search’, system will search the security device name, and IP address and port. 

Users can add the device information by selecting the list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note 

 

 

■ VMS automatically starts a connection to ticked addresses in Site 

Manager after login. 

■ A connection doesn’t happen for un-ticked security devices.  

■ There is no limit for registering sites in VMS. 
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4.2  User Manager 

User Manager is to register and manage ID of the program users. It decides the program 

to be executed or blocked by confirming ID and password and also gives different 

authority to each user group for all functions in the program. 

 

Administrator as a fundamental user is registered in the administrator group. The 

administrator group has authority for all functions in the program. For the first time login, 

use initial administrator ID.  

 

 

4.2.1 User Group Registration 

1. Select ‘System’->’User Manager’ menu. “User & Group Manager” window shows up. 

 

2. Select User Group tab. 

 

3. Click on ‘Add’ at the bottom of the group list. 

 

4. Enter a group name and tick on desired functions from the group permission list. 

 
Note ■ The number of users to be registered is unlimited. 



 13 

 

 

5. Click on ‘Ok’ and selected functions are granted to the user group. The user group 

name will be shown at the user group list. 

 

 

 

4.2.2 User Registration 

1.  Select ‘System’->’User Manager’ menu. User & Group Manager setup window 

shows up. 

 

2. Select User tab. 

 
Note 

 

■ In order to register a user group, users must log in with one of ID 

from the administrator group. For the first time login, use the initial 

registered administrator. 
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3. Click on ‘Add’ at the bottom of the group list. 

4. Enter a user name and password and select a group from User Group. The user 

name and password are the basic requirement. 

 

 

5. Click on ‘Ok’ and the user name will be shown at the user list. 

 

 

 

 Note 

 

■ In order to register a user, users must login with one of ID from the 

administrator group. For the first time login, use initial administrator 

ID. 
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5.  Menu 

5.1  View 

View menu is used to configure a collection of the panel window. 

No. Menu Icon Function 

①  Site Connection List  Site Connection List Panel View 

②  Event List 
 

Event List Panel View 

③  Site Status List  Site Status List Panel View 

④  Basic Control Function 
 

Basic Control Panel View 

⑤  Pop up Image List 
 

Pop up Image List Panel View 

⑥  Multi. screen 
 

Multi. Screen Panel View 

⑦  Network Player 
 

Network Player Execution 

⑧  Backup Player 
 

Backup Execution 

⑨  Device Setup Manager 
 

Device Setup Manager Execution 

⑩  Heath Manager 
 

Health Manager Execution 

⑪  Program Information 
 

Program Information View 
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5.2  System 

5.2.1 Log Manager 

Log Manager is to manage the event log of security devices and the activity of the 

program function.  

5.2.1.1  Log View 

1. Select ‘System’->’Log Manager’ menu. “Log Search Manager” window shows up. 

 

 

2. For the user activity log, select ‘User Action’ tab. Dates saved with logs will 

be marked in the calendar. Select a desired date and log information will be 

shown. Users can search by user, time and actions. 
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3.  For the event log and alarm log of security devices, select ‘Event’ tab. Dates 

saved with logs will be shown in the calendar. Select a desired date and log 

information of events and alarms will be shown. Searching by user, security 

device/PC time, site and event are available. 

 

 

4. For the security device log, select ‘DVR Log’ tab. Dates saved with the log 

history will be shown in the calendar. Select a desired date and the log 

information of the security devices will be shown.  
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5.2.1.2  Data Save 

1. For program log, event and log data back, select the backup button. After set of 

the save path, the search results will be saved by csv format. 

 (csv file can be opened at Micron soft Excel) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Note 

 

■ The time used in ‘User Action’ log is based on PC time. The time 

used in ‘Event’ and ‘DVR Log’ is based on the time of the security 

device. 
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5.2.2 App Setup 

The program environment setting is available. 

OSD, Language, Backup, Auto Lock, Connect, Disconnect, Callback can be set. 

 

5.2.2.1 Configuration 

1. In ‘Connect’, users can configure the auto reconnection trial interval when the 

device was disconnected.  

 

 

2. In ‘Storage’ tab, users can designate saving folders for the capture image file, 

record file and DVR firmware file, 
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3. In ‘OSD’ tab, users can configure the name, height, thickness and color of the font to 

be displayed above the live monitoring screen. Also it sets up Enable/Disable of the 

time, resolution, title and other information to be displayed above the screen. 

 

4. In ‘Border Line’ tab, users can configure the thickness and color of the border line 

that indicates the border line between channels in real-time monitoring. 

 

5. In ‘Auto lock’ tab, users can configure the auto rock interval of VMS program. 

VMS program go to the background process after the auto lock interval. User can 

recall the program by selecting the VMS from the system ray icons.  
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6.  In ‘Live record’ tab, users can select the record the live monitoring images or the 

record the images when the events are occurred.  

7. In ‘Display’ tab, users can change the pixel size and setup the video filter. Also a 

size, font and color of letters; ‘Connecting’, ‘Signal Loss’ and ‘Video Disconnect’ can 

be decided. In, Screen Ration, users can configure the live image, display ration 

which is  

 

        

[Screen Real ratio is on]                   [Screen real ratio is off]  

 

8. In ‘Playback’ tab, users can setup the vertical playback mode and last image display 

mode.  

 

9. In ‘Language’ tab, users can select languages including English, Korean, Japanese, 

Turkish, Italian, Polish, Chinese, French. 

 

5.3  Setup 

5.3.1 Edit Password 

1. Select ‘Setup’->’Edit Password’ menu. Edit Password setup window shows up. 

 

 

2. Users can change the password of current logged-in user ID. 
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5.3.2 User Information 

1. Select ‘Setup’->’User Information’ menu. User Information setup window shows up. 

 

2. The name, group and group authority of the current logged-in user are displayed. 
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5.3.3 Alarm Manager 

1. ‘Setup’->’Alarm Manager’. Alarm Schedule Manager setting window will be 

appeared. 

 

2. The Alarm type(Alarm Out, Instant Live, Popup Image) can be selected at DVR List.  

 

 

3. At Alarm Manager, by pressing ‘Alarm Setting’ each Alarm setting (options) will be 

available. 
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- Alarm Out 

Sound setting at Alarm. System Beep/Wave File 

- Instant Live (Event Live Popup) 

Instant Live popup images numbers setting available. 

- Event Popup Image 

Popup image max save number, the date of image files creation, image file size.   

- Signal Loss Alarm Delay 

Latency time after camera signal loss. 
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6. Live Viewer 

6.1  Live Viewer Overview 

The “Live viewer” is a multi-channel real-time program displaying a customized screen 

of multi-channel real-time monitoring images. 

 

The viewer is a main function of the program and incorporates all program menus. It 

consists of various panels including Site Connection List, Screen Layout List, Event List, 

Basic Control Function and Status List Popup Image. 

 

Users can check real-time events, status and connection information of the security 

device connected in Site Connection List, Event List and Status List. In Screen Layout 

List, users can customize channels and modes for real-time monitoring. In Popup Image, 

an image of the important event moment is captured and saved in an image format. In 

Basic Control Function, it provides PTZ, Relay, Two way Audio, Color Adjustment, 

Sequence and other functions. 

 

6.2  Image View 

In Viewer, there are three ways to have the real-time monitoring image. The first way is 

to drag a security device icon into the screen and all channels of the security device are 

displayed. The second way is to drag cameras from the security device list to desired 

locations of the screen and the selected camera will be displayed at the selected location. 

The third way is to collect cameras of the security devices in Screen Layout Function. 

  

 

 

 

 

 

 Note 

 

 

 

 

■ The channel mode automatically changes according to the number of 

added cameras when the user drag/drop icons. 

■ Images being displayed in the viewer move to other locations by 

dragging images. 

■ images exchange each other if a image is dragged onto an occupied 

location. 
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6.2.1 Image View by connecting security devices 

1. In Site Connection List, select a desired security device icon to be monitored. 

 

2. Drag the icon into the viewer screen, and then all channel of the security device are 

displayed. 

 

 

 

 

 

 

 

 

 

 Note 

 

 

 

■ To disconnect the security device, right-click on a desired icon, and 

then select ‘Disconnect’ in the popup menu. 

■ The channel mode automatically changes according to the number of 

channels. 

■ The max. number of channels to be displayed in the viewer are 64. 
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6.2.2 Image View by connecting cameras 

1. In Site Connection List, double-click on a connected security device icon to enlist t 

to be real-time monitored. Select camera icons from the camera list of the security 

device. 

 

2. Setup a layout by selecting a channel mode in Channel Mode. 

 

 

3. Drag camera icons onto the viewer screen, and then real-time monitoring images  

are displayed 

  

 

 

 

 

 Note 

 

■ To disconnect the camera, drag a desire monitoring image out of the 

viewer screen. 

■ Users can setup the layout by 1, 4, 6, 8, 9, 10, 13, 16, 25, 36, 49, 64 

channel mode. 
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6.2.3 Image View through the triple monitor 

1. In View menu, select the second screen or click on  button in Tool Bar. The 

second monitor screen shows up. 

 

 

2. Move the second screen to the second monitor 

 

3. Setup the layout by selecting a channel mode in Channel Mode.  
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4. Repeat 6.2.1 or 6.2.2 to bring images on the second screen and third screen.  

5. Select the  icon to save the each layout name and description. 

Saved layout will be shown on the layout list from connect list panel.  

 

 

 

 

 

 

 

 

 

 

 

Note 

 

■ To disconnect the camera, drag a desire monitoring image out of the 

second viewer screen. 

 

Caution 

 

■ To use more than two monitors, the video card in PC must support 

the dual-monitor or more. 
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6.3  Event List 

6.3.1 Event Information View 

1. In View menu, select an event list or click on  button in Tool Bar. The event list 

window pops up. 

 

2. Events occurred in connected security devices automatically are indicated in the 

event list.(No setup needed) 

 

 

 

6.4  Status List 

6.4.1 Security Device Status Information View 

1. In View menu, select a status list or click on  button in Tool Bar. The status list 

shows up. 

 

2. The status list shows status of the connected camera including PTZ Connection, 

Video Disconnect, Signal Loss and HDD status, and also indicates Two way Audio 

enable/disable, Relay enable/disable and HDD occupied/total capacity. 

 

 

 

 

 

Note 

 

■ The event list window is a docking window so that users can place 

the icon at a desired location and have a separate window. 

 

Note 

 

■ The status list window is a docking window so that users can place 

the icon at a desired location and have a separate window . 
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6.5  Popup Image 

Popup Image is a sub window showing a thumbnail transmitted from the security device 

when an event occurs. Setup in ‘App Setup’. 

 

 

6.5.1 Thumbnail Image View in Popup Image Window 

1. In View menu, select a popup image or click on  button in Tool Bar. The popup 

image window shows up. 

 

2. The thumbnail image automatically shows if an event occurs from connected 

security devices. (Setup needed in App Setup) 

 

 

 

 
Note 

 

■ To bring thumbnail in case of the event occurrence, tick on ‘Event 

Popup Image’ in ‘Instant Live’ tab at ‘App Setup’. (For more 

information, refer to ‘5.2.3’ App Setup.) 
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6.6  Basic Control 

Basic Control consists of PTZ control, Relay control, Two way Audio, Color adjustment, 

Screen sequence and other functions. 

 

6.6.1 PTZ Control 

PTZ Control is to control the PTZ camera with functions including Move, Zoom In/Out, 

Focus Adjustment, Preset, Speed Adjustment and Tour 1/2. 

 

 

PTZ Movement Control 

1. Select a PTZ camera to be moved. 

2. Move the PTZ camera by pressing four direction keys. 

  

 

PTZ Focus Control 

1. Select a PTZ camera to be focus-controlled. 

2. Press   button to adjust the focus. 

 

PTZ Zoom Control 

1. Select a PTZ camera to be zoom-controlled. 

2. Press   button to zoom in/out. 

 

PTZ Preset Control 

1. Select a PTZ camera to be preset-controlled. 
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2. Select a preset number and press  button. The camera moves to a preset 

position. 

3. To designate a certain position as a preset position, move the camera to a desired 

position and select a preset number, and then press  button. The position is 

saved as the preset position. 

 

PTZ Speed Control 

1. Select a PTZ camera to be speed-controlled. 

2. Adjust the speed by moving the sliding bar .  The speed of the PTZ camera gets 

faster or slower. 

 

PTZ Tour Control 

1. Select a PTZ camera to be tour-controlled. 

2. Press  button and the PTZ camera moves according to the tour no.1. Press  

button and the PTZ camera moves according to the tour no.2. 

 

6.6.2 Relay Out Control 

Relay Out Control is to setup the relay On/Off that is connected to the security device. 

The number of Relay Out varies depending on security devices. 

 

1. Select a site to be relay out-controlled from the list. 

2. Press  button and request a relay out-control to the security device. 

3. Status of the relay out is shown by  (Off) (On) buttons. 

4. The button is designed to be toggled. (On->Off, Off->On) 

 

 

 

 

Note 

 

■ The time out of the relay out is 5 seconds. After 5 seconds, the user 

has to request it again. 
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6.6.3 Two way Audio Control 

Two way Audio Control is to send an audio sound from the program to a speaker of the 

security device. 

 

 

1. Select a site to be two way audio-controlled from the list. 

2. Press  button and speak to a mike connected to PC. 

3. A voice comes out of the speaker connected to the security device. 

 

 

6.6.4 Color Adjustment 

It is to adjust color of the real-time monitoring image in the “Live viewer” panel.  

 

 

1. Select a screen to be color-adjusted. 

2. Adjust the value of Brightness, Gamma, Contrast, Saturation and Tint. 

3. All channels can be adjusted with the same value by ticking on ‘All Channel’. 

 

 

Note 

 

■ The time out of the two way audio is 120 seconds. After 120 

seconds, the user has to request it again. 

 

Note 

 

■ The color adjustment value returns to the default value when 

program terminates.  
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6.6.5 Screen Sequence Function 

Screen Sequence Function is to rotate the layout of the real-time monitoring image in 

the viewer screen according to a desired time interval. 

 

1. Select a channel mode. (1, 4, 9, 16 channel mode) 

2. Select a rotation time interval. (2seconds ~ 60seconds) 

3. Press  button and it starts the rotation according to the set value. 

 

6.6.6 Other Functions 

Other functions include real-time monitoring screen capture, printing of the captured 

image, real-time image recording and full screen. 

 

1. Press button and it saves the real-time monitoring screen as a file and brings the 

image editor ‘Picture Viewer’. This editor allows users to edit images by using the 

color adjustment and filter. (In 5.2.3 App Setup -> Storage tab, a saving folder is 

shown.) 
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2. Press  button and it starts to record the real-time monitoring screen and audio 

together. The saved file can be played through ‘File Player’. 

3. Press  button and it changes to the full screen. Press ‘ESC’ key for return. 

4. Press  button. A captured image file list is shown and selecting one of them 

leads to the image in the reporting format document. Press the ‘Print’ button. 

 

 

6.7  Callback function 

At certain events at DVR, you can be alarmed by VMS through the connection of the port 

and IP set at VMS. Event List(basic), Popup Text(basic), Popup Image, Instant Live, Alarm 

List can be used for the Alarm to users. 

 

6.7.1 Setting and operation 

1. Callback Port setting 

At VMS Menu > System > App Setup >Callback tab, you can set the port for callback 

receiving as below. (Default Callback port : 9000) 

 

2. Callback Alarm Setting 

Basically, Popup Text and Event List will be appeared for the attention at Callback 

Event. Additional Alarms such as Popup Image, Instant Live, Alarm Out List can be 

set at VMS Menu > Setup > Alarm Manager. 

  

3. Callback Alarm Operation 

After Callback Alarm setting above, you can check Callback Event at real time. 

 

- Event List (Basic) 
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- Popup Text (Basic) 

 

- Alarm Out Box 

 

- Popup Image 

 

- Instant Live 
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7.  Playback 

7.1  Playback overview 

Playback allows users to search and playback recorded images and audios of the 

security device in multi-channel from distant PC. 

Users can use a preview search to find recorded images and audios. Searching and   

thumbnails by a second term are available. Users can download images and audios of the 

desired time period into PC. 

 

7.1.1 Playback of the Recorded Image 

1. Select  icon in Tool Bar. 

2. Setup searching conditions (Camera/Security device, Date/Time) in the searching 

panel of the player at top left. 

3. Designate a desired time to be played in ‘Go to’ and press (start) button. 
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7.2  Search 

 

Users can search recorded images and audios in the security device by two means; the 

time line search and POS search.  

 

The time search is to designate a certain date/time and bring images appertaining to 

the designated date/time. 

 

The POS search is to select a certain date and hour. A time line between 0minute 

0second ~ 59minutes 59seconds shows up. Users can view thumbnail images by 1 second 

term. 

 

 

7.2.1 Time line Search 

1. Select  icon in Tool Bar. 

2. Select a security device to be played from ‘Connect List’ at the top-left. 

3. Select a date and time to be searched. 

 

 

 

7.2.2 POS Search 

1. Select  icon in Tool Bar. 

2. Select a security device to be played from ‘Connect List’ at the top-left. 

3. Select a date and time to be searched and press  button. 

4. Setup a desired time to be searched at ‘Go to’, bottom-left and press  button. 

The time line of the preview search is shown. 

 

Note 

 

■ The player can display recorded images of max. 16 cameras at the 

same time. (One security device) 

 

Note 

 

■ The way of the search in the player may be different 

from the way in the security device. 

 
Note ■ Users can select max. 16 cameras. 
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5. As the time bar moves by one second term in the preview search, the preview 

thumbnail changes accordingly. 

 

 

 

6. ‘To re-setup preview search conditions, press  default button. 

 

 

7.3  Playback 

 

7.3.1 Playback Overview 

After searching images and audios by two means, searched images and audios are 

played automatically if the user presses a playback button. The channel mode is 

automatically determined according to the number of cameras. 

 

In the playback screen, the channel title, date/time and other information are displayed. 

Also, rectangular boxes with event colors are displayed at the bottom-left. 

 

Multi-channels are played in the division mode. Double-clicking on a certain channel 

leads to the full screen. For return, double-click on the full screen. 

 

In the time line, image information (recording event status) being played is indicated in 

 
Note ■ Users can select max. 16 cameras. 
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color. Users can move the bar and play at a desired location and also the snapshot and 

printing are available. 

 

7.3.2 Time Line 

Time Line indicates images and audios of the designated search condition and events by 

each channel in graphic lines. 

 

The green line indicates that a recorded data exists. The red line means that an event 

recording data exists. The green space is that there is no data. Using a scroll at right, 

users can check the recorded event data from channel 1 to 16. 

 

7.3.3 Playback Control 

It indicates images and audios of the designated search condition and events by each 

channel in graphic lines. 

Button Function Remark 

 Fast Reverse  

 Reverse Play  

 Reverse one frame  

 Pause  

 Play one frame  

 Play forward  

 Fast Forward  

 
Play Speed Adjustment  

 

 button for speed up,  button for slow 

down. 

 

 Indication by events in the time line  

 

 

 

 

Caution 

 

■ Some of the security devices may not be supported with all 

functions. 
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7.3.4 Control 

In Player, users can use a channel mode change, full screen, zoom function, capture and 

print function. 

Button Function Remark 

    Playback in 1, 4, 9, 16 channel mode  

 Full Screen  

 

Image Enlargement (100%, 150%, 200%, 300%, 

500%, 700%, 1000%, 1600%) 

 

 Screen Capture  

 Screen Print  

 

7.4  Download 

In Download, users can download and save recorded images and audios from the 

security device to PC. 

 

7.4.1 Download of the Recorded Data 

1. Select Network Player[ ] in Tool Bar. The playback window will show up. 
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2. Select a security device to be played from ‘Connect List’ at the top-left. 

3. Press  button and the download window pops up. 

4. In the download window, setup a start date/time and end date/time, and then tick on 

desired channels and designate a saving route. 

5. Press ‘Start’ button to initiate downloading.  

 

 

8.  Backup Player 

8.1  Backup Player Overview 

Backup Player is to search and play a downloaded image/audio file in the PC in multi-

channel screen. 

 

Smart Search enables users to find the designated time by searching the thumbnails 

when the motion detected. 

 

8.1.1 Playback of the Recorded Data 

1. Select  icon in Tool Bar. 

2. In Tool Bar, select a data folder by pressing   or  button. (In ‘File’ menu, 

users can select ‘Folder Open’ or ‘File Open’.) 

 
Note 

■ The download data is saved as a folder and the folder name is “start 

date/time_end date/time”. 
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3. It starts playing recorded data files. 

 

 

8.1.2 Time Line 

Time Line indicates images and audios of the designated search condition and events 

by each channel in graphic lines. 

 

 

The green line indicates that a recorded data exists. The red line means that an event 

recording data exists. The green space is that there is no data. Using a scroll at right, 

users can check the data of the recorded events from channel 1 to 16. 

 

8.1.3 Playback Control 

It indicates images and audios of the designated search condition and events by each 

channel in graphic lines. 

Button Function Remark 

 Fast Reverse  

 Reverse Play  

 Reverse one frame  

 Pause  

 Play one frame  
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 Play forward  

 Fast Forward  

 
Play Speed Adjustment  

 

 button for speed up,  button for slow 

down. 

 

 Indication by events in the time line  

 

 

8.1.4 Control 

In Player, users can use a channel mode change, full screen, zoom function, capture and 

print function. 

Button Function Remark 

    Playback in 1, 4, 9, 16 channel mode  

 Full Screen  

 

Image Enlargement (100%, 150%, 200%, 300%, 

500%, 700%, 1000%, 1600%) 

 

 Screen Capture  

 Real time recording  

 Screen Print  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Caution 

 

■ Some of the security devices may not be supported with all 

functions. 
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8.2  Smart Search 

Smart Search is to search a motion in the specific area of the recorded image data. 

Searched images are saved as thumbnail images in time sequence. 

8.2.1 Smart Search 

1. Select  button in Tool Bar. (Select ‘Smart Search‘ in ‘Tool’ menu) 

2. Setup a desired area to be motion-searched. 

 

3. Select a desired channel to be smart-searched, start date/time and end date/time. 

4. In Time Interval, select ‘All Images’ or ‘Time Interval (sec). 

5. Press ‘Search’ button and it starts smart-searching 

 

6. Select searched thumbnail images and press ‘Playback’. It starts the playback from 

the selected time period. 
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8.3  Water Mark Search 

     Searched data (thumbnail image format) will be listed for the storage.  

 

8.3.1 Water Mark Search 

1. Select  button at program toolbar. (At ‘Tool’ menu, select ‘Water Mark search’) 

2. After selection of the channel, press Water Mark search button. Then Water mark 

search will be started. 

 

3. At the selection of searched thumbnail image, you can play the file by pressing 

‘Playback’ button.  

 

9. Video Encoder 

9.1  Video Encoder Overview 

     By Video Encoder, downloaded file of MPEG4 or H.264 formatted can be transformed 

into MPEG1 or AVI format by which the recorded file can be played at Windows Media 

Player. 

 

9.2  Video Encoder Start/ Operation 

1. Go to [Start] > [Program] > [VMS] and click the [Video Encoder]. 
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2. Video Encoder execution. 

 

3. By Add button or dragging the files or folder, downloaded and recorded files can be 

added to the encoding list. 

 

 

4. By selection of ‘Preview / Set Segment’, the time to be encoded will be set. 
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5. On Click of ‘Setting’, Video Codec, Resolution, Quality, Date Type, Audio Sync of the 

selected data will be set. 

 

 

 

6. After set of Output file path, press ‘Start’ button for the transformation.  
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10. Health Manager 

10.1 Health Manager Overview 

    By Health Manager, users can monitor the status of the remoted devices such as 

connection, camera information, recording information, recording status, network status The 

current results monitored can be backed up by *.csv format. 

10.2 Health Manager Start/ Operation 

1. Select  icon at program toolbar. 

2. Health Manager will be executed. 

(The list of the DVR registered at VMS address will be displayed orderly) 

  

3. Select  button at program toolbar. 

4. User can configure the Check time interval  

 

 

5. At menu > File > Export, the current data monitored will be save by *.csv format 

(Excel format compatible) 
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11. Remote Upgrader 

11.1 Remote Upgrader Overview 

    By Remote Upgrader, security device will be simply updated with F/W  

through PC remotely. 

11.2 Remote Upgrader  Start/Operation 

1. Start > Program> VMS > Remote Upgrader. 

 

2. Remote Upgrader execution as below. 

 

 

3. Input the IP Address, Port, UserID, Password of the remote device for F/W update, 

then select the upgrade file(*.bin). 

 

4. Clidck the ‘Upgrade’ then the upgrade file will be transferred to the remote device. 
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5. After the transfer finished, automatic upgrade will be done at the Security device. 

 

 

12.  DVR Setup Manager 

12.1 DVR Setup Manager Overview 

By DVR Setup Manager, DVR setup will be available from the remote PC. The setup 

data can be applied to other DVRs and adjusted at the file format. 

12.2  DVR Setup Manager Start 

1. Select  button at the program toolbar. 

2. Setup data of the security can be changed by DVR setup manager.  

3. The changed setup data will be transferred to the security device by pressing ‘Send’ 

button.  

 
Caution 

■ Without Hard Disk mounted at the Security device, the remote 

upgrade function might not be supported.  
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12.3 Setup Data Open &Save 

1. At ‘File’ menu, select Open > setup data. 

2. After change of the setup data, save the setup data by the selection of ‘save’ at ‘file’ 

menu. 

3. The changed setup data can be transferred to security device by pressing ‘Send’ 

button then the setup data will be applied at the security device.  

 

12.4  Setup Data Reset and DVR ALL Reset 

1. ‘At file menu, all setup data can be reset by selection of ‘Setup Data Reset’.  

2. ‘At file menu all setup of DVR will be reset by selection of ‘DVR All Reset’. 

3. Changed setup data will be applied at DVR by pressing ‘Send’ button.  

 

 
Caution 

 

■ By ‘DVR All Reset’, the security device will be set as factory 

default. By this, remote access will not be available from the 

change.  


